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Software License Agreement

Please read this agreement carefully before using the software.

If you do not agree with the terms and conditions of this Agreement, return the software
package to PhotoTune, or to the location where you obtained it. By using this software, you
agree to be bound by the terms and conditions of this license.

The enclosed computer program (“Software”) is owned by PhotoTune Software and is li-
censed, not sold, to you by PhotoTune Software for specific use under the terms of this license
only. The term “Software” shall also include any upgrades, modified versions, updates, addi-
tions and copies of the Software licensed to you by PhotoTune Software. PhotoTune Software
grants to you a nonexclusive license to use the Software and documentation, provided you
agree to the following:

1. LICENSE. This license allows you to: (a) Install and use one copy of the software on
a single computer which is not accessible by multiple computers. That same user may also
make a copy of the Software to use on a portable or home computer which is primarily used
by said user; (b) make one copy of the Software in machine readable form solely for backup
purposes; (c) transfer the software from one computer to another provided the software is
used on only one computer at a time; (d) permanently transfer (not rent or lease) the Software
to another party by providing to such party all copies of the licensed Software along with a
copy of this License and the accompanying written materials provided the party agrees to be
bound by the terms and conditions of this License, and you may not retain any of the copies
of the product after the transfer.

2. RESTRICTIONS. (a) The Software contains trade secrets and may not be modified,
translated, reverse engineered, decompiled, disassembled, nor any attempt made to discover
the source code of the Software, or create derivative work based on the Software; (b) you may
not sublicense, rent or lease any portion of the Software package; (c) notwithstanding any
other terms in this License, if the Software is licensed as an upgrade or update, you may only
use the Software to replace previously licensed versions of the same software. The upgrade
or update does not constitute the granting of a second license to the Software, and you may
not transfer the software which is being replaced to a third party.

3. TERMINATION. This License is effective until terminated. This License will terminate
immediately without notice from PhotoTune Software or judicial resolution if you fail to comply
with any provision of this License. Upon such termination you must destroy the Software, all
accompanying written materials, and all copies thereof.

4. EXPORT LAW ASSURANCES. You agree that the Software will not be shipped, trans-
ferred or reexported, directly or indirectly, into any country prohibited by the United Stated
Export Administration Act and the regulations thereunder or will be used for any purpose
prohibited by the Act.

5. LIMITED WARRANTY. PhotoTune Software warrants that the Software will perform
substantially in accordance with the documentation, and be free from defects in materials and
workmanship under normal use for a period of ninety (90) days from your date of purchase.
To make a warranty claim, you must return the entire software package with the original sales
receipt to the location where you obtained it within the ninety (90) days. The entire and exclusive
liability and remedy shall be limited to the replacement of the Software, or the refund of the
purchase price you paid for the Software package.

THIS LIMITED WARRANTY IS THE ONLY WARRANTY PROVIDED BY PHOTOTUNE SOFT-
WARE. PHOTOTUNE SOFTWARE AND ITS LICENSOR DISCLAIM ALL OTHER WARRANTIES,
EITHER EXPRESSED OR IMPLIED. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION
OF IMPLIED WARRANTIES OR LIMITATIONS TO A SPECIFIC TIME PERIOD FOR THE WAR-
RANTY, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

6. LIMITATIONS. In no event will PhotoTune Software any licensor, employee or affiliate of
any of the foregoing be liable to you for any consequential, incidental, indirect, or special dam-
ages whatsoever (including, without limitations, damages for loss of business profits, business
interruption, loss of business data and the like), whether foreseeable or unforeseeable, arising
out of the use of the Software, or your inability to use the Software.

SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF LIMITATION OF LIABILITY
FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT
APPLY TO YOU.

7. GOVERNMENT END USERS. If the software is supplied to the United States government
the Software is classified as “RESTRICTED COMPUTER SOFTWARE” as defined in clause
52.227-19 of the FAR. The United States government’s rights to the Software are as provided
in clause 52.227-19 of the FAR.

8. GENERAL. This is the entire Agreement between us and supersedes any other commu-
nication, advertisements, or understanding with respect to the Software and documentation.

© 2004 PhotoTune Software. All Rights Reserved.

This manual, and the associated software, is furnished under license and may only be used
or copied according to the terms of said license. This User Guide, readme file, release notes,
and other related material is for your information only, and is subject to change without notice.
PhotoTune Software assumes no responsibility or liability for any errors or inaccuracies that
may appear in this book.

No part of this publication may be reproduced, or transmitted in any form, or by any means,
without the prior written permission of PhotoTune Software.

SkinTune and PhotoTune Software are trademarks licensed to PhotoTune Software. Adobe
and Photoshop, are registered trademarks of Adobe Systems, Inc. Apple, and Macintosh are
registered trademarks of Apple Computer, Inc. Microsoft and Windows are registered trade-
marks of Microsoft Corporation. All other trademarks not specifically named are the property
of their respective owners.

SkinTune is protected by a U.S. Patent Pending.
Written and designed by PhotoTune Software.
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Windows Installation

1.) Double-click on Installer.exe to run the setup program. If the installer can’t
find Photoshop, use the Choose button to locate Photoshop’s Plug-ins folder. It is
normally located in C:\Program Files\Adobe\Photoshop\Plug-Ins.

2.) Next time you use Photoshop, SkinTune will appear as a new menu item
under Photoshop’s Filter menu. Look for PhotoTune SkinTune.
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System Requirements
SkinTune is a Photoshop plug-in, compatible with:

Photoshop 7 and CS, Photoshop Elements 2, Jasc PaintShop Pro, and Corel
PhotoPaint.

Windows 98 to XP.
Minimum screen resolution of 800x600
24 bit RGB images. File types include Tiff, JPEG, Photoshop, BMP, and PICT.

Serial Number

Macintosh OSX Installation

1.) Move or copy SkinTune into Photoshop’s Plug-ins folder located in the Ap-
plications Folder on your hard drive.

2.) Next time you use Photoshop, SkinTune will appear as a new menu item
under Photoshop’s Filter menu. Look for PhotoTune SkinTune.
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System Requirements
SkinTune is a Photoshop plug-in, compatible with:

Photoshop 7 and CS, or Photoshop Elements 2.
Mac OSX 10.2+.
Minimum screen resolution of 800x600

24 bit RGB images. File types include Tiff, JPEG, Photoshop, BMP, and PICT.

When you start SkinTune, a dialog box will appear giving you an opportunity to enter your serial number by clicking the Register
button. Be sure to enter your name, company, and serial number to activate the program. Until a serial number is entered, SkinTune
will be restricted to demo mode, which provides 20 sessions before timing out.
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Welcome To SkinTune

Thank you for purchasing SkinTune. We appreciate your
support.

SkinTune is an Adobe Photoshop compatible Plug-in that
automatically corrects skin color.

Face Facts

If you’re a fashion, portrait, or wedding photographer, you
know first-hand how difficult it is to correct skin color. You
tweak, adjust, and experiment with Curves, but the slightest
alteration can cause an unwanted color shift.

At PhotoTune, we’ve solved the problem by compiling complete skin-tone
libraries for different national origins, including African, Asian, European, Latin, and
Middle Eastern.

All you do is open an image in Photoshop, and select PhotoTune SkinTune from
the Filter menu. After two clicks of the mouse, SkinTune instantly finds the nearest
acceptable skin color from the selected library, and automatically corrects your
image. Each library contains more than 25,000 different colors that encompass the
entire flesh tone spectrum.

After SkinTune does its magic, you’re free to fine-tune the results by adjusting
hue, brightness, and saturation. All your adjustments will stay within the boundar-
ies of the library to insure perfect, lifelike results.
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Interface Design

After you click to select a flesh
tone, SkinTune displays your Original
image alongside the Current corrected
image. A complete set of tools lets you
fine-tune and perfect the results.

National Origin Pop-Up

Skin-tone Libraries for African,
Asian, European, Latin, and Middle
Eastern are available under the pop-up
menu. Each library contains more than
25,000 different skin colors.

Percentage Radio Buttons

SkinTune adjusts your image to the
nearest acceptable color in the chosen
library, based on your click point. The
50% option cuts the adjustment in half,
while 25% reduces the adjustment in
half, again.

Saturation Slider
To start, saturation matches the
click point of your original image. Alter-

ing saturation will not effect color or —__

brightness.

m Snapshot

The Snapshot command
lets you make a temporary copy of the
Current preview, along with a record
of your corrections. That way, you can
compare different results, and experi-
ment with different alterations without
losing your prior changes.

The Original and Current Pop-up
menus under the preview images con-
trol Snapshot functions.

Portrait. Tif
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Color Swatches

SkinTune displays a set of colors
that can be used to adjust the Current
image. The active color is highlighted
with a green outline. Click on a differ-
ent color to choose a new target color.

The color swatches are arranged in
rows with different brightness levels,
while columns contain different color
variants or hues.

Brightness Slider

The scroll bar at the end of the color
swatches controls brightness. Scroll up
for lighter colors and down for darker
colors.

Reset Button

The Reset button reverts to the
original correction which was applied
when you clicked to select a skin-tone.
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Zoom Slider /

To begin, the image is always
reduced to fit. The vertical Zoom slider
lets you increase or decrease the size
of the preview images.

{m;. Pan Tool
If the image is cropped, you
can reposition it using the pan tool.

Macintosh - Option Click and drag
Windows - Control Click and drag.



clicking on a
skintone

Start The Correction Process

To begin, open an image in Photoshop, and then choose PhotoTune SkinTune
from Photoshop’s Filter menu.

A single image is displayed in the left preview area. All the tools are grayed out
and inaccessible. Only the Zoom slider and image panning can be used at this
time.

The first step is to use your mouse to select a flesh tone in the original image.
After you click, a contextual menu appears listing the available skin-tone libraries,
based on national origin. Choose a library.
African HH

Asian Note: See page 7 for more information regarding
European the selection process.
Latin

Middle Eastern
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Once you make a skin-tone and library selection, several things happen:
1. The selected skin-tone area is marked with a box.

2. The corrected Current image is displayed on the right.

3. The tools become active.

4. The color swatches are displayed.

5. The RGB, CMYK and Saturation values for the selected skin-tone area are
displayed to the side of the Original and Current images.
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Preliminary Photoshop Corrections
SkinTune is designed to make precise skin color adjustments, and is not
intended for general purpose corrections.

Before using SkinTune, you should use Photoshop to set the dynamic range,
adjust brightness, and perform any necessary sharpening.

DO NOT use Photoshop to alter Hue or Saturation. SkinTune will handle those
functions for you.

Click Points
Your flesh tone selection is an important first step in achieving good results.
Here are some things to consider:

1. Select a mid-tone color. Choose an area that is a good representation of the
average color, brightness, and saturation of the image.

2. Avoid shadows and highlights.
3. Avoid facial hair and make-up.

4. The program takes a 7x7 pixel average based on your click point, so choose a
smooth, uniform area.

5. At any time, you may select a new click-point, which will reset the results.

Color Swatches

After choosing a flesh tone, SkinTune automatically adjusts the Current preview
image so that the click-point matches the nearest acceptable flesh tone in the
library. SkinTune color swatches can be used to adjust the result.

The highlighted square is the target color used to adjust the Current preview. If
you select a different color swatch, it becomes the new target color and is high-
lighted to indicate the change.

1. The color or hue can be fine-tuned by selecting a color to the right or left of
the target color.

2. To lighten the image, choose a color that is above the target color, and to
darken the image choose a color below the target color. The scroll bar can also be
used to change the brightness.

Lighter

Darker
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National Origin Pop-up menu.
Eutapean E] The pop-up contains choices for African, Asian,
European, Hispanic, and Middle Eastern. Each item
has its own library. This is initially set with the Contextual menu, which appears
after making a skin-tone selection.

Choosing a different item from the National Origin pop-up will reset the correc-
tion process. The Current image, color swatches, target color, and saturation slider
will be reset, and any alterations you made will be ignored.

Percentage Radio Buttons

SkinTune adjusts your image to the nearest acceptable color in the chosen li-
brary, based on your click point. The 50% option cuts the adjustment in half, while
25% reduces the adjustment in half, again.

Saturation Slider

Saturation can be increased or
decreased with the slider. To begin, the
saturation matches the click-point in your original image. So, if you adjust satura-
tion, and later want to return to the previous amount, just set the slider to match
the densitometer reading located to the left of the original image.

Saturation =y 44

When the slider is adjusted, both the image and the color swatches are imme-
diately updated to reflect the new Saturation value.

Brightness Slider

The scroll bar at the end of the color swatches controls brightness. Scroll up to
lighten the image and down to darken the image. To begin, the brightness match-
es the click-point in your original image.

Target Color
The Target color is used to adjust the Current image. It is highlighted with a green
border.

You can alter the Target color by changing the saturation or brightness, and
you can click on a different color swatch to make it the Target Color. Different Hues
are arranged horizontally, with warmer colors to the left and cooler to the right.

Zoom Slider

To the right of the image area, you’ll find a vertical
Zoom slider, which can be used to increase or decrease
the size of the preview images. When the slider is acti-
vated, the zoom percentage is displayed in the corner of
T the image area.

You can NOT freely adjust the image size. The slider jumps to the next available
percentage, which is determined by Photoshop.

Moving the slider handle up increases the image size,
while down reduces the size.

When you open an image in SkinTune, the image is always reduced to fit in the

available image area.

{ﬂ-? Most images appear full-frame in SkinTune, unless the image has
been enlarged with the zoom slider or if the image is excessively tall or

wide, as with panoramic images. In these cases, the image display is cropped,

and only the center portion of the image is in view. Once you make a skin-tone

selection, zooming will use your click-point as the center.

Hand Tool

You may reposition the image by using the hand tool, which is accessed with a
keyboard shortcut.

Macintosh: Option Click and drag.
Windows: Control Click and drag.

Reset Button

When you click on the Reset button, SkinTune re-
verts to the previous settings that were present when
you last clicked on an image with the eye dropper tool.

' i

PR T TR— Y
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The correction process starts over whenever you use the eye dropper tool to
select a flesh tone.

Furthermore, when two images are displayed, you may click on either preview
image. You may also click and drag the selection rectangle to a new location.
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Snapshot

The Snapshot command lets you make a temporary copy (or snap-
shot) of any state of the Current image. A snapshot lets you work from
that version forward, while retaining the information used to create the Snapshot.
In this way, you can experiment, or compare different effects.

For example, you can take a snapshot, and then tweak amounts to compare
different results. Then, take another Snapshot any time you have made an im-
provement, and continue experimenting. With snapshots, you can recover your
work easily. If you’re not satisfied with your changes, you can select the snapshot
to undo all the steps which were made after the Snapshot. Use Revert To Snap-
shot to reload the Snapshot adjustments.

The “Original” and “Current” pop-up menus, located under the image previews,
are used to control the Snapshot process.

A camera icon, located on the Tool Palette allows you to take a Snapshot. You
can also use the “Take Snapshot” option located in the Current pop-up menu.

By clicking the camera icon, the Current, right-hand image preview is recorded
as a Snapshot, along with its adjustments. The Snapshot preview is displayed on
the left, where the Original preview was located. At this point, the Snapshot and
Current are duplicates. The Current image can be adjusted as normal. Each new
Snapshot is handled in this way.

There is always a Snapshot. A Snapshot survives a reset, or OK (Apply).

If you’ve taken a Snapshot, it is saved when the image is processed (OK), so
when you reopen SkinTune to color correct a new image, the Snapshot from the
previous session is available.

The pop-up menus contain the following items:

Left Menu Right Menu
Original Current
Snapshot Take Snapshot

Revert To Snapshot

Save History...
Load History...

Revert to Snapshot
There is only one Snapshot and one Current preview. If you want to switch from
the Current to the Snapshot, use the pop-up menu item “Revert To Snapshot”.

When Revert To Snapshot is selected, the Snapshot is displayed in the right-
hand window, and overwrites any edits that have been made to the Current
preview since the Snapshot was created. The Snapshot becomes the Current
preview. The tools are updated with the changes that were used to create the
Snapshot. The Current preview can be edited as normal.

Save History and Load History

Only one Snapshot is remembered. An unlimited number of Snapshots can be
made, but each new Snapshot overwrites the previous Snapshot. But, you can
save an unlimited number of Snapshots to disk. To save to disk, choose the Save
History option in the Current pop-up menu, and specify a name and location for
the file. Use the Load History option to open and apply a previously saved setting.
You can edit the Saved History using all of the tools on the Fine-Tune Panel.
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Using SkinTune With Photoshop
e

2. Open SkinTune, and make changes as you normally would. The corrections
will only be applied to the selected areas.

o To use SkinTune on selected areas
H‘h 1. Choose one of Photoshop’s selection tools from the tool
palette, and select a portion of the image.

Photoshop Layers

';":IL M.'I.I -1::‘:1" ; ,'"Ill, & Photoshop lets you place artwork on separate
e B Ty ] layers to make the construction of composite im-

. r ages easy. SkinTune is designed to work with Pho-
sl toshop layers, so you can color correct individual
- elements separately.

i To use SkinTune with layers
- 1. Display the layers palette (choose

Window>Show Layers).

2. To activate a layer and work on its contents,
{ click on the appropriate layer name listed in the
o Layers palette. The layer is highlighted to show that
lé/dlalielwl - it has been selected. Then, open SkinTune.

3. To work on a portion of one layer, select the layer as described above and
use a selection tool to select a portion of that layer. Next, open
SkinTune. The adjustments will be applied to the selected area.
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Batch Processing
SkinTune supports Photoshop’s Action Palette, so multiple images can be pro-
cessed automatically, with SkinTune’s functions.

Using Photoshop’s Actions
1. From within Photoshop’s Action Palette, start a new Action.

2. Photoshop will record every step, including SkinTune functions, so they can
be replayed on a batch of images automatically.

3. To replay the action on a single image, select the action in the action palette,
and select “play”.

To replay the action on multiple images, choose Automate>Batch from Photo-
shop’s File menu. A dialog lets you select an action, choose a folder of images to
process, and set other parameters for opening, closing, and saving files.

Last Filter

SkinTune supports Photoshop’s Last Filter command located at the top of the
Filter menu. This lets you replay SkinTune’s last correction on other images. The
menu item is available until you use a different filter.

Fade

SkinTune supports Photoshop’s Fade command, located in the Edit menu.
This allows you reduce the effect of the SkinTune’s last adjustment from 0-100%.
The Fade command is similar to changing the layer opacity in Photoshop’s Layer
Palette.
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